## Table of Contents

1. Displaying Thumbnail Images and Performing Basic Edits in the Main Window
2. Performing Detailed Edits in the Edit Window
3. Performing Detailed Edits in the Edit Image Window
4. Displaying an Image in the Quick Check Window
5. Reference

### Canon Utilities
- Digital Photo Professional Ver.2.0

### Compatible Models
- EOS-1D Mark II N
- EOS-1Ds Mark II
- EOS-1D Mark II
- EOS-1Ds
- EOS-1D
- EOS 5D
- EOS DIGITAL REBEL XT/350D DIGITAL
- EOS 20D
- EOS DIGITAL REBEL/300D DIGITAL
- EOS 10D
- EOS D60
- EOS D30
- PowerShot Pro1
READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]). IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX (COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single computer. You may physically transfer the SOFTWARE from one computer to another provided that the SOFTWARE is used on only one computer at a time. You shall not install or use the SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware configuration where the SOFTWARE is accessible to more than one CPU or to more than one user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for use of the SOFTWARE. No updates, fixes or support will be made available for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, maintain and match the hardware and software components of your computer system. Thus Canon does not guarantee uninterrupted service or correction of errors or that the functions or performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the SOFTWARE is warranted only against defective material under normal use for a period of ninety (90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall be replacement of the same without charge when returned by you at your expense to your point of purchase and proven to be defective upon inspection. The replacement CD-ROM will be warranted for the remainder of the original ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to anyone other than the original user of the SOFTWARE.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate without notice to you if you fail to comply with any of the terms of this Agreement and you must then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in the United States of America shall be governed and construed in all respects in accordance with the laws and regulations of the State of New York, without reference to choice of law principles. The terms of this Agreement as it relates to purchases of the Software in Canada shall be governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of the SOFTWARE is subject to the United States, Canada and other applicable copyright and trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any images, graphics or textual material that you save in connection with the SOFTWARE.

10. ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED OFFICER OF CANON.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS LIABLE FOR ANY DAMAGES HOWEVER CAUSED, INCLUDING WITHOUT LIMITATION, DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]). IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX (COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.
Introduction

This chapter includes information on the precautions to be read before using Digital Photo Professional, how to use this Instruction Manual, the system requirements and the supported image types. It also explains the functions and window structure, and gives examples of operation.

About This Manual

Thank you for purchasing this Canon product. Precautions for using this product safety and icons to help you with procedures, etc. are described at the beginning of this Instruction Manual. Please be sure to read these first before proceeding to the information in the other chapters.

- It is prohibited to reproduce, in whole or part, the contents of this Instruction Manual without permission.
- Canon may change without notice the software specifications and contents of this Instruction Manual.
- The software screens and displays printed in this Instruction Manual may differ slightly from the actual software.
- The content of this Instruction Manual has been reviewed thoroughly. However, if you should notice any errors or omissions, please contact a Canon Service Center.
- Please note that irrespective of the above-mentioned, Canon does not take responsibility for the outcome of the operation of the software.

Safety Precautions

Please read the safety precautions carefully before using this product. Ensure that you use the product correctly according to the procedures described in these instructions. The following safety precautions are intended to instruct you in the safe and correct operation of the product and its accessories to prevent injuries or damage to yourself, other persons and property. Please read and ensure that you understand them before you proceed to the other sections of these instructions.

**Warning**

Do not play the supplied CD-ROM(s) in any CD-ROM Player that does not support data CD-ROMs. The extremely loud sound that may result from playing the CD-ROM(s) in an audio CD player (music player) could damage the speakers. It is also possible to suffer hearing losses from listening with headphones to the loud sounds of a data CD-ROM played on a music CD player.

Trademark Acknowledgments

- Canon and EOS are trademarks of Canon Inc.
- iBook, iMac and QuickTime are trademarks of Apple Computer Inc.
- Macintosh, PowerBook and Power Macintosh are trademarks of Apple Computer Inc., registered in the United States and other countries.

How to Read the Manual and the Conventions Used

- In this manual, the screens used in the examples are from Mac OS X 10.3.
- In this document, square brackets [ ] are used to indicate items such as window names, menu names and button names that appear on the computer screen.
- Text inside <> in this document indicates the keys on the keyboard and camera button names.
- Asterisk in (p. *-) in this document shows reference pages.
- In this document indicates the sequence of operation as shown below. Example: [View] menu \[Sort\] \[File name\]

The explanations given below describe the type of content indicated by the respective icons.

- Marks information that should be read before use to prevent problems that would interfere with the functioning of software and computer.
- Marks additional information that you will find helpful.

Click any of the chapter content buttons at the right of the Instruction Manual to display the front page of each chapter.
Clicking the buttons on the bottom right of the Instruction Manual allows you to move as follows:

- Displays the previous page.
- Displays the next page.
- Returns to the previously displayed page.
Main Features

Digital Photo Professional (DPP) software is designed for editing RAW images shot with Canon digital cameras and has the following features and functions to meet the requirements of professional and high-end amateurs who mainly shoot RAW images.

### High-speed processing of RAW images

- DPP has made possible, using Canon’s own high performance algorithm, high-speed processing and high-speed display of RAW images.
- DPP, Canon’s genuine software, has made possible high-image quality processing.

### Operation and window variety that can respond to a professional’s workflow

- DPP’s operation is easy, compatible with the workflow of a professional, and has a variety of function windows.
- In the main window, images can be displayed as a list (thumbnail image display), selected, rearranged, and basic editing can be performed.
- In the edit image window, one of multiple images can be selected and enlarged, checked, and detailed editing can be performed.
- In the edit window, one image can be enlarged, checked, and detailed editing can be performed.
- In the quick check window, images can be displayed one after the other, checked and selected.

### Real-time image editing

- DPP has various image editing functions where the results of editing are reflected in an image in real-time.
- You can adjust all image editing functions with 16 bit high precision.
- DPP can perform various kinds of image editing with the RAW image adjustment function that is richer and has a larger degree of freedom than the image adjustment features of the camera. It also has the RGB image adjustment function that can edit RAW images and RGB images (JPEG images, TIFF images). There is almost no image deterioration of RAW images edited with the RAW image adjustment function.
- RAW image adjustment features:
  - Brightness adjustment, white balance adjustment, Picture Style setting.
  - RAW image and RGB image (JPEG images, TIFF images) adjustment features:
    - Tone curve adjustment, color adjustment, sharpness, trimming, image correction (repair, copy stamp), image rotation (90° to the left or right).
  - DPP can save, import or apply recipe data (results of various adjustments made to an edited image) to other images.
  - The before and after editing comparative display function allows you to compare and adjust an image displayed in a window showing the before and after versions.

### A diversity of functions

- DPP can select and organize images using 3 kinds of check marks.
- DPP can send one image to Photoshop or a batch of multiple images to optional image editing software.
- DPP can print single copies of compatible images including RAW images.

- Together with Easy-PhotoPrint and Canon BJ printers, DPP can print compatible images including RAW images simply and in high quality.
- DPP can convert and save RAW images as TIFF or JPEG images and attach an ICC profile.
- DPP can convert and save a batch of multiple RAW images (batch processing).
- DPP can change a batch of file names (rename function).
- Together with EOS Capture, DPP is compatible with remote shooting.

### Color management

- DPP is compatible with Color Management System.
- DPP is compatible with 5 kinds of color space (sRGB, Adobe RGB, Wide Gamut RGB, Apple RGB, ColorMatch RGB).
- DPP can attach ICC profiles to a saved image.
- DPP can set monitor and printer profiles.
- With the CMYK simulation function, DPP can simulate the color of an image when printed with a printer, etc. in a CMYK environment.

System Requirements

<table>
<thead>
<tr>
<th>OS</th>
<th>Mac OS X 10.2 to 10.4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>Macintosh with one of the above OS preinstalled</td>
</tr>
<tr>
<td>CPU</td>
<td>400MHz G3 or higher</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum 512MB</td>
</tr>
<tr>
<td>Hard disk space</td>
<td>256MB or more</td>
</tr>
<tr>
<td>Display</td>
<td>Resolution: 1024 × 768 or more</td>
</tr>
<tr>
<td></td>
<td>Colors: Thousands or more</td>
</tr>
</tbody>
</table>

- This software program is not compatible with UFS (Unix File System) formatted disks.

Supported Images

This software supports the following image types.

<table>
<thead>
<tr>
<th>Image type/Camera used</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAW images</td>
<td>.CR2</td>
</tr>
<tr>
<td>EOS-1D Mark II N, EOS-1Ds Mark II, EOS-1D Mark II, EOS 5D, EOS DIGITAL REBEL XT/350D DIGITAL or EOS 20D</td>
<td></td>
</tr>
<tr>
<td>EOS-1Ds, EOS-1D</td>
<td></td>
</tr>
<tr>
<td>EOS DIGITAL REBEL/300D DIGITAL, EOS 10D, EOS D60, EOS D30 or PowerShot Pro1*</td>
<td></td>
</tr>
<tr>
<td>CRW</td>
<td></td>
</tr>
<tr>
<td>JPEG images</td>
<td>.JPG, .JPEG</td>
</tr>
<tr>
<td>Exif 2.2 or 2.21-compatible JPEG or JFIF images</td>
<td></td>
</tr>
<tr>
<td>TIFF images</td>
<td>.TIF, .TIFF</td>
</tr>
<tr>
<td>Exif-compatible TIFF images</td>
<td></td>
</tr>
</tbody>
</table>

*You cannot edit with the Digital Photo Professional RAW image editing function.
Function Window Configuration

Digital Photo Professional comprises the windows and function windows shown below, centering on the main window that is displayed when DPP starts up.

Main window
- Images can be displayed as thumbnails, and basic image editing can be performed (p.1-2).
- The size of images and the way images are displayed can be changed or images can be sorted according to a selected condition (p.1-5).
- Images can be sorted and organized using 3 kinds of check marks (p.1-2).
- For RAW images, white balance and brightness can be adjusted, and color space can be set (p.1-6 to p.1-9).
- RAW, JPEG and TIFF images can be rotated and brightness adjusted (p.1-2, p.1-9).
- RAW images can be converted into JPEG and TIFF images, and edited images can be saved as separate images* (p.1-15).
- Images (including RAW images) can be printed* (p.1-19).
- All settings for Digital Photo Professional can be made* (p.1-20).
- * This can also be done in the edit window and the edit image window.

Edit window
- An image selected in the main window can be enlarged and displayed in a separate window. Also, you can display up to 36 edit windows to compare and edit images (p.2-2).
- The size of images and the way images are displayed can be changed, or a comparison of an image before and after editing can be displayed (p.2-3).
- For RAW images, brightness and white balance can be adjusted, and Picture Style can be set (p.2-3 to p.2-6).
- Tone curve and color can be adjusted for RAW, JPEG and TIFF images (p.2-6 to p.2-8).

Quick check window
- Images selected in the main window can be quickly displayed in a separate window and viewed (p.4-1).
- Images can be sorted and organized using 3 kinds of check marks (p.4-1).

Rename window
- A batch of file names can be changed (p.1-17).

Trimming window
- An image can be trimmed within your desired range (p.1-10).

Copy stamp window
- An image can be corrected so that unwanted spots in the image blend with surrounding color (p.1-11).
- An image can be corrected by pasting a section copied from another part of the same image to an unwanted part of the image (p.1-12).

Tools menu
- Switch
- Double-click
- Button or menu

Copy stamp window

Tools menu

Importing images from EOS Capture
- With EOS Capture, images shot remotely can be displayed (p.1-19).

Transferring images to image editing software
- Multiple images can be transferred to optional image editing software (p.1-18).

Tools menu

Printing with Easy-PhotoPrint
- Images can be printed with Easy-PhotoPrint on Canon BJ printers (p.1-19).

Transferring an image to Adobe Photoshop
- One image can be transferred to Adobe Photoshop (p.1-18).

Tools menu

Window for batch conversion and saving of images (batch processing)
- A batch of multiple RAW images can be converted and saved to JPEG or TIFF images, and a batch of edited images can be saved as separate images (p.1-16).

Tools menu

Cover/Table of Contents

Introduction

Displaying Thumbnail Images

Performing Basic Edits in the Main Window

Performing Detailed Edits in the Main Window

Performing Detailed Edits in the Edit Window

Displaying an Image in the Quick Check Window

Reference

Index
Example of Operation

The following shows typical flows of operating Digital Photo Professional.

**Example 1: Displaying Thumbnail Images and Performing Basic Edits in the Main Window**

2. Display images in the main window (p.1-2).
4. Select an image and perform basic edits (p.1-6, p.1-9).
   - Print the images (p.1-19).
   - Transfer images to image editing software (p.1-18).

**Example 2: Selecting One Image from Multiple Images and Performing Detailed Edits on the Image in the Edit Image Window**

2. Select multiple images in the main window (p.1-2).
3. Switch to the edit image window (p.3-1).
4. Select one image from multiple images (p.3-1).
5. Edit the image (p.2-3, p.2-6).
   - Display the image as a comparison of before and after editing (p.2-3).
   - Print the image (p.1-19).
   - Transfer images to image editing software (p.1-18).

**Example 3: Performing Detailed Edits on a Single Image in the Edit Window**

2. Select an image in the main window (p.1-2).
3. Display the image in the edit window (p.2-2).
4. Edit the image (p.2-3, p.2-6).
   - Display the image as a comparison of before and after editing (p.2-3).
   - Print the image (p.1-19).
   - Transfer an image to Photoshop (p.1-18).
5. Save edits (recipe data) to the image (p.1-13). Convert and save the edited image as a separate image (p.1-15).

**Example 4: Checking Images in the Quick Check Window**

2. Select multiple images in the main window (p.1-2).
3. Display the images in the quick check window (p.4-1).
4. Check the images. Set a check mark to an image (p.4-1).

**Example 5: Applying the Editing Data (recipe data) of an Edited Image to Another Image**

2. Select the edited image in the main window (p.1-2).
3. Copy the editing data (recipe data) (p.1-13).
4. Select the image to which the editing data will be applied in the main window.
5. Apply the editing data to the selected image (p.1-13).

**Example 6: Remote Shooting with EOS Capture**

1. Connect the camera to your computer and turn the camera on.
2. Start up Digital Photo Professional (p.1-2).
3. Switch to the main or edit image window (p.1-2, p.3-1).
5. Take a shot by clicking the [Shoot] button in EOS Capture or pressing the shutter button on the camera.
6. Check the image, which is displayed in the main or edit image window.
This chapter describes the functions of the main window, and how to display images and perform basic edits on them.

- **Starting up Digital Photo Professional** ............................................................. 1-2
- **Displaying Images** .......................................................................................... 1-3
- **Handling the Folders** ..................................................................................... 1-4
  - Creating a New Folder
  - Registering Frequent Use Folders with the Bookmark
  - Organizing Bookmarks
  - Copying an Image
- **Deleting Images** .............................................................................................. 1-5
- **Selecting the Image Display Mode** ................................................................ 1-5
  - Selecting the Thumbnail Size
  - Image with Information Display
  - Sorting Images
  - Displaying Image Information
  - Displaying the Edit Window
  - Displaying the Edit Image Window
  - Displaying the Quick Check Window
- **Editing RAW Images** ..................................................................................... 1-6
  - Adjusting the White Balance
  - Click White Balance Function
  - Adjusting the Brightness
  - Specifying Color Space
- **Editing Images** ................................................................................................ 1-9
  - Adjusting the Brightness
  - Trimming Images
  - Correcting an Image
- **Using Edits (Recipe Data)** ............................................................................ 1-13
  - Saving the Recipes
  - Loading and Pasting Recipes
  - Copying Recipes and Applying to Other Images
- **Reverting Edited Images to Their Original Condition** ................................. 1-14
  - Reverting to Last Saved Settings
  - Reverting to Shot Settings
- **Saving Edited Images** ................................................................................... 1-14
  - Saving by Overwriting
  - Saving and Renaming
  - Adding a Thumbnail of the Image
  - Converting and Saving RAW Images while Renaming Them
  - Converting and Saving Images in a Single Operation (Batch-processing)
- **Changing File Names in a Single Operation** .................................................. 1-17
- **Transferring Images to Image Editing Software** ............................................. 1-18
  - Transferring One Image to Photoshop
  - Transferring Multiple Images to Image Editing Software
- **Printing Images** ................................................................................................ 1-19
  - Printing with Easy-PhotoPrint
- **Displaying Images in EOS Capture** ............................................................... 1-19
- **Specifying Preferences** .................................................................................. 1-20
Starting up Digital Photo Professional

Click [Digital Photo Professional] registered in the Dock.

- The main window is displayed.
- Alternatively, you can start up Digital Photo Professional by double-clicking the [Canon Utilities] folder \ Digital Photo Professional] folder \ [Digital Photo Professional] icon.

Menu bar
Displays the [Digital Photo Professional], [File], [Edit], [View], [Bookmark], [Adjustment], [Tools] and [Window] menus.

The main window switches to the edit image window (p.1-6, p.3-1).

Selects all the images in the image display area.

All the selected images in the image display area are deselected.

Folder area
The images in the selected folder are displayed in the image display area.

Displays the coordinates of the cursor position and the RGB values (8-bit conversion) of an image while operating the click white balance (p.1-8).

Displays whether or not recipe data (p.1-13) is attached to the selected image.

When you set CMYK simulation profile (p.1-21), [CMYK] is displayed.

To select an image, click the target image.
To select multiple images, hold down the <ctrl> key and click the images.
To select sequential images, click the first image and then hold down the <shift> key and click the last image.

For information on shortcut keys, refer to the "Shortcut List" (p.5-2).

Starting up Digital Photo Professional

Click [Digital Photo Professional] registered in the Dock.

- The main window is displayed.
- Alternatively, you can start up Digital Photo Professional by double-clicking the [Canon Utilities] folder \ Digital Photo Professional] folder \ [Digital Photo Professional] icon.

Menu bar
Displays the [Digital Photo Professional], [File], [Edit], [View], [Bookmark], [Adjustment], [Tools] and [Window] menus.

The main window switches to the edit image window (p.1-6, p.3-1).

Selects all the images in the image display area.

All the selected images in the image display area are deselected.

Folder area
The images in the selected folder are displayed in the image display area.

Displays the coordinates of the cursor position and the RGB values (8-bit conversion) of an image while operating the click white balance (p.1-8).

Displays whether or not recipe data (p.1-13) is attached to the selected image.

When you set CMYK simulation profile (p.1-21), [CMYK] is displayed.

To select an image, click the target image.
To select multiple images, hold down the <ctrl> key and click the images.
To select sequential images, click the first image and then hold down the <shift> key and click the last image.

For information on shortcut keys, refer to the "Shortcut List" (p.5-2).
Displaying Images

You can display images saved on your computer in the main window.

Click the folder in which images are saved.

- You cannot display images saved on a memory card in the camera. You must save images to your computer using other software supplied with the camera or a third-party card reader.
- A JPEG image set to Adobe RGB and taken with the EOS 10D, EOS DIGITAL REBEL/300D DIGITAL or PowerShot Pro1 may display with the sRGB color space applied.
- Refer to "Supported Images" for information about the images that can be displayed (p.0-2).
- Images that cannot be displayed appear as [X].
- Images that were shot with the camera held vertically with [Auto rotate] setting to <ON> are automatically displayed vertically.
- You can display images saved on a memory card using a third-party card reader.

The following shows the information displayed when [Large thumbnail] (p.1-5) is selected.

- This mark is displayed for images being trimmed (p.1-10).
- This mark is displayed when a check mark is set (p.1-2, p.4-1).
- This mark is displayed when an image that has been corrected with the copy stamp tool (p.1-11, p.1-12).
- The file name.
- This mark is displayed for images for which the RGB processing (p.1-9, p.2-6) was performed.
- This symbol is displayed for images for which the brightness was adjusted (p.1-9).
- This mark is displayed for images for which the white balance was specified.
- This mark is displayed for images that have been corrected with the copy stamp tool (p.1-11, p.1-12).
- No symbol is displayed for JPEG and TIFF images.
- This mark is displayed for images being trimmed (p.1-10).

Information Displayed with Images

- This value is displayed for RAW images for which the brightness was adjusted (p.1-9).
- The icon for the specified white balance is displayed with RAW images only (p.1-7).
- The [RAW] symbol is displayed for RAW images. (When [Small thumbnail] is selected, the [R] symbol is displayed). No symbol is displayed for JPEG and TIFF images.
- The [RAW] mark is not displayed for PowerShot Pro1 RAW images.
Handling the Folders

You can handle the folder on the menu that appears by clicking on the folder while holding down the <control> key.

Click on the folder while holding down the <control> key, and then select an option from the menu that appears.

- You can drag and drop folders in the folder area to move them to the other folders. You can also copy the folders by dragging and dropping them while holding down the <option> key.

Creating a New Folder

You can create a new folder in the folder area.

1. In the folder area, select the location where the new folder is to be created.
2. Select the [File] menu ➤ [Create New Folder].
   - The create new folder dialog box appears.
3. Enter a folder name.
   - The folder is created.

Registering Frequent Use Folders with the Bookmark

You can register frequent use folders with the [Bookmark] menu.

1. Select a folder in the folder area.
2. Select [Bookmark] menu ➤ [Add].
   - The selected folder is registered with the [Bookmark] menu.
3. The registered folder can be selected from the [Bookmark] menu.

Organizing Bookmarks

You can change the name of the folder or delete the folder that was registered with the [Bookmark] menu.

1. Select [Bookmark] menu ➤ [Organize].
   - The [Sort bookmarks] dialog box appears.
2. Change the folder name or delete the folder.
   - To change the folder name, select the folder in the bookmark folder area, change the displayed folder name, and then click the [Change] button.
   - To delete the folder, select the folder in the bookmark folder area, then click the [Delete] button.
3. Click the [Close] button.

You can handle the folder on the menu that appears by clicking on the folder while holding down the <control> key.

Click on the folder while holding down the <control> key, and then select an option from the menu that appears.

- You can drag and drop folders in the folder area to move them to the other folders. You can also copy the folders by dragging and dropping them while holding down the <option> key.

Creating a New Folder

You can create a new folder in the folder area.

1. In the folder area, select the location where the new folder is to be created.
2. Select the [File] menu ➤ [Create New Folder].
   - The create new folder dialog box appears.
3. Enter a folder name.
   - The folder is created.

Registering Frequent Use Folders with the Bookmark

You can register frequent use folders with the [Bookmark] menu.

1. Select a folder in the folder area.
2. Select [Bookmark] menu ➤ [Add].
   - The selected folder is registered with the [Bookmark] menu.
3. The registered folder can be selected from the [Bookmark] menu.

Organizing Bookmarks

You can change the name of the folder or delete the folder that was registered with the [Bookmark] menu.

1. Select [Bookmark] menu ➤ [Organize].
   - The [Sort bookmarks] dialog box appears.
2. Change the folder name or delete the folder.
   - To change the folder name, select the folder in the bookmark folder area, change the displayed folder name, and then click the [Change] button.
   - To delete the folder, select the folder in the bookmark folder area, then click the [Delete] button.
3. Click the [Close] button.
Copying an Image
You can copy and save an image to another folder.

1. Select the image to be copied.
2. Select the [Edit] menu ➤ [Copy].
   ➔ The image is copied.
3. Select the folder to which the image is to be saved.
4. Select the [Edit] menu ➤ [Paste].
   ➔ The image is copied to the selected folder.

Deleting Images
You can move unnecessary images to the Trash on your computer and delete them.

1. Select images and then select [File] menu ➤ [Delete].
   ➔ The images are moved to the Trash.
2. Select [Finder] menu on the desktop ➤ [Empty Trash].
   ➔ The images are deleted.

Images that you deleted in step 2 cannot be restored. Check carefully before deleting images.
When multiple images are selected, all the selected images will be deleted. Take particular care when you have just finished a task involving the selection of multiple images.

In addition to [CRW_YYYY.CRW] (RAW images) and [IMG_YYYY.JPG] (JPEG images), [CRW_YYYY.THM] (images for displaying camera indexes) is saved in the folder [xxxCANON] where images you have taken with the EOS 10D, EOS DIGITAL REBEL/300D DIGITAL, EOS D60, EOS D30 and PowerShot Pro1 are saved. With Digital Photo Professional, [CRW_YYYY.THM] images are not displayed and therefore you cannot move or delete them. Move or delete [CRW_YYYY.THM] images on the Finder. [xxx] of folder names and [YYYY] of image names represent a number.

Selecting the Image Display Mode
You can change the size or method and sort images according to a selected condition.

Selecting the Thumbnail Size
The available image sizes are [Large thumbnail], [Middle thumbnail], and [Small thumbnail]. Various information (p. 1-3) is displayed in the display frame.

Select [View] menu ➤ Select the size to be set.
   ➔ The images are displayed in the selected size.

Image with Information Display
You can display the brightness histogram and the shooting information for images.

Select [View] menu ➤ [Thumbnail with information].
   ➔ The images with attached information are displayed.

Sorting Images
You can sort images according to a condition you select.

Select [View] menu ➤ [Sort] ➤ Select the condition to be set.
   ➔ The images are sorted according to the selected condition.

- [File name] : File names are sorted in alphanumeric order (0 to 9 to a to z).
- [RAW priority] : Displayed in the following order: RAW images (CR2 → CRW → TIF) → RGB images (JPG → TIF)
   If multiple images have the same extension, they are sorted in order of [File name].
- [Check mark1] : Displayed in the following order: check-marked images with selected number → check-marked images with other numbers → images without check marks
   If multiple images have the same check mark number, they are sorted in order of [File name].
- [Shooting Data/Time] : Sorted by shooting date and time. If multiple images were taken on the same date and time, they are sorted in order of [File name].
Displaying Image Information
You can check various information for images.

Select an image and then select [File] menu ➤ [Info].
→ The image information appears.

Image information may not appear for JPEG images set to Adobe RGB and shot with the
EOS 10D, EOS DIGITAL REBEL/300D DIGITAL or PowerShot Pro1.

Displaying the Edit Window
You can enlarge the image and perform detailed edits.

Double-click an image.
→ The edit window appears.

Select multiple images and then click the [Edit image window] button.
→ The main window switches to the edit image window.

Displaying the Edit Image Window
You can select one image from multiple images and perform detailed edits.

Select multiple images and then click the [Edit image window] button.
→ The main window switches to the edit image window.

Displaying the Quick Check Window
You can individually display images in a larger size and can quickly view and check each image.

Select multiple images and then select the [Tools] menu ➤ [Start Quick check tool].
→ The quick check window appears.

Editing RAW Images
You can perform various edits on the RAW images that are supported by Digital Photo Professional. With RAW image editing (p.1-6 to p.1-9), there is hardly any of the deterioration which accompanies image editing. You can therefore edit an image multiple times while preserving the image quality at the time the image was shot.

1. Select a RAW image.
2. Edit the RAW image (p.1-6 to p.1-9).
   - You can apply edits to other images by copying and pasting the edit data to the other images (p.1-13).
   - You can revert edited images to the last saved settings or shot settings (p.1-14).
3. Save the edited image (p.1-14).

Adjusting the White Balance
You can set the white balance with each method.

   → The [White balance adjustment] dialog box appears.
   - Alternatively, you can display this dialog box by selecting [Adjustment] menu ➤ [White balance].
2. Adjust the white balance by making each setting (p.1-7, p.1-8).
3. Click the [Close] button.
Selecting the White Balance
You can specify the white balance.

Select the white balance from the list box.

### White Balance

<table>
<thead>
<tr>
<th>White Balance</th>
<th>Details</th>
<th>Color Temp. K (Kelvin)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shot settings</td>
<td>To apply the white balance setting used when the shot was taken.</td>
<td>—</td>
</tr>
<tr>
<td>Auto</td>
<td>Automatically adjusts the white balance.</td>
<td>Approx. 3000 to 7000</td>
</tr>
<tr>
<td>Daylight</td>
<td>For sunny daylight outdoors.</td>
<td>Approx. 5200</td>
</tr>
<tr>
<td>Shade</td>
<td>For shaded areas outdoors.</td>
<td>Approx. 7000</td>
</tr>
<tr>
<td>Cloudy</td>
<td>For cloudy or hazy days and during sunset.</td>
<td>Approx. 6000</td>
</tr>
<tr>
<td>Tungsten light</td>
<td>For tungsten (light bulb) light.</td>
<td>Approx. 3200</td>
</tr>
<tr>
<td>Fluorescent light</td>
<td>For white fluorescent light.</td>
<td>Approx. 4000</td>
</tr>
<tr>
<td>Flash</td>
<td>When flash is used.</td>
<td>Approx. 6000</td>
</tr>
<tr>
<td>Color temp.</td>
<td>You can manually set color temperature for 2800 to 10000K (in 100K increments).</td>
<td>Approx. 2800 to 10000</td>
</tr>
<tr>
<td>Click white balance</td>
<td>Displayed for images on which you performed the click white balance.</td>
<td>—</td>
</tr>
</tbody>
</table>

### Specifying the Color Temperature
You can specify the color temperature in the range of 2800 to 10000K (in 100K increments).

1. Select [Color temp.] from the list box.

2. Adjust an image while viewing it.

Drag the slider left or right to adjust the color temperature. The adjusted value appears.
Adjusting with the Color Wheel
You can select a desired color from the color wheel. You can also specify the hue in the range of 0 to 359 (in 1-stop increments), and the saturation in the range of 0 to 255 (in 1-stop increments).

1. Click the [Tune] button.
   - The color wheel appears.

2. Adjust an image while viewing it.
   - Drag [ ] to adjust an image.

Personal White Balance
You can apply the personal white balance (p.2-4) that you registered in the edit window or the edit image window to images.

   - The registered personal white balance is applied to the image.

   ![Image of color wheel]
   You can enter a value or click the [ ] / [ ] buttons to specify the hue and saturation.

2. Click White Balance Function
   Makes white the standard for the point you selected and color in the image is adjusted.

   1. Click the [Click (RAW)] button (p.1-2).
      - When you move the cursor over the image, the cursor [ ] changes to [ ].

   2. Click the point where is to be the standard.
      - The color in the image is adjusted with white as the standard on the point you selected.
      - If you click on another point over the image, the white balance is adjusted again.
      - When you finish this operation, click the [Click (RAW)] button.

   ![Image of white balance function]
   - The coordinates of the cursor position and the RGB values (8-bit conversion) of the image are displayed in the lower left of the main window (p.1-2).
   - The image is adjusted based on the value of 1 × 1 pixels from the clicked point.
   - Even if you have selected a neutral gray point of the image, the result of adjustments is the same as when you select a white point.
Adjusting the Brightness
You can adjust the brightness in the range of –2.0 to +2.0 (in 0.01-stop increments when entering a value).

1 Click the [Brightness (RAW)] button (p.1-2).
   → The [Brightness adjustment] dialog box appears.
   Alternatively, you can display this dialog box by selecting [Adjustment] menu ➔ [Brightness adjustment (RAW)].

2 Adjust an image while viewing it.
   Drag the slider left or right to adjust the brightness.
   [Brightness adjustment] dialog box
   - Adjusts the brightness of an image.
   - Drag the slider left or right to adjust the brightness.
   - Enter a value to adjust the brightness.
   - Click the [Close] button.

Specifying Color Space
You can set a color space other than the one set in [Default settings of Work color space] in the preferences (p.1-21).

Select [Adjustment] menu ➔ [Work color space] ➔ Select a color space to be set.
   → The selected color space is set.

The specified color space is added to the ICC profile that is embedded in TIFF or JPEG images that have been converted from RAW images and saved (p.1-15, p.1-16).
A color space is the reproducible color range (the characteristics of color gamut). Digital Photo Professional supports the following 5 kinds of color space.

- sRGB: Standard color space for Windows. Widely used for the standard color space of monitors, digital cameras, and scanners.
- Adobe RGB: A wider color space than sRGB. Mainly used for printing for business purposes.
- Wide Gamut RGB: A wider color space than Adobe RGB.
- Apple RGB: Standard color space for Macintosh. A slightly wider color space than sRGB.
- ColorMatch RGB: A slightly wider color space than sRGB. Mainly used for printing for business purposes.

Editing Images
You can perform various edits on the RAW, JPEG, and TIFF images that are supported by Digital Photo Professional.

1 Select an image.

2 Edit the image (p.1-9 to p.1-12).
   - You can apply edits to other images by copying and pasting the edit data to the other images (p.1-13).
   - You can revert edited images to the last saved settings or shot settings (p.1-14).

3 Save the edited image (p.1-14).
   Before quitting Digital Photo Professional, you must save the edited images (p.1-14).
   - When multiple images are selected, the edits are applied to all the selected images.
   - The editing data can be saved in a separate file (p.1-13).
   - The edited images can be transferred to image editing software (p.1-18).

Adjusting the Brightness
You can adjust the brightness of an image in the range of –100 to +100 (in 1-step increments when entering a value).

1 Select [Adjustment] menu ➔ [Brightness adjustment].
   → The [Brightness adjustment] dialog box appears.

2 Adjust an image while viewing it.
   Drag the slider left or right to adjust the brightness.
   [Brightness adjustment] dialog box
   - Adjusts the brightness of an image.
   - Drag the slider left or right to adjust the brightness.
   - Enter a value to adjust the brightness.
   - Click the [Close] button.
Trimming Images

You can trim an image within your desired range.

1. Select the [Tools] menu ➔ [Start Trimming tool].
   → The trimming window appears.

2. Trim the image.
   - Select a ratio from the [Aspect ratio] list box, and drag the trimming range as shown in the diagram.

   ![Diagram of trimming window]
   - Displays the coordinate position of the cursor. When you have set the trimming range, the upper left and lower right XY coordinates, width, height and aspect ratio of the frame are displayed.
   - Displays the upper left coordinates of the trimming range you have set. You can also set the coordinates by entering your desired numbers.
   - Copies the trimming range you have set.
   - Displays the full screen. To return to the original view, click this button again.
   - Displays borders around the trimming range.
   - Displays the next image. *Functions when you have selected multiple images and the trimming windows are displayed.
   - Displays the previous image. *Functions when you have selected multiple images and the trimming windows are displayed.
   - Displays the ratio selected from the [Aspect ratio] list box. You can also enter your own ratio when you select [Custom] from the [Aspect ratio] list box.
   - Displays the size of the trimming range you have set. You can also set the size by entering your desired numbers.
   - The trimming range copied from another image is reflected in the image displayed.*
   - Drag the slider left or right to set the level of opacity outside the trimming range.
   - Displays the image that appears by clicking on the image while holding down <control> key.
   - Displays the next image.* Functions when you have selected multiple images and the trimming windows are displayed.

3. Click the [OK] button.
   - You can also set the [Aspect ratio] and switch between full screen/normal screen from the menu that appears by clicking on the image while holding down <control> key.
   - For information on shortcut keys, refer to the "Shortcut List" (p.5-3).
Correcting an Image
You can correct an image using the repair function or the copy stamp function.

Repairing
You can correct an image so that unwanted spots (spots you want to delete) on the image blend with surrounding color.

1 Select the [Tools] menu ➔ [Start Stamp tool].
   ➔ The copy stamp window appears.

2 Click the [100% View] button.
   ➔ The image is displayed in the 100% view.

3 Display the section you want to correct.
   • Drag the image to display the section you want to correct.

4 Click the [Repair (Light)] button or the [Repair (Dark)] button.
   • When the unwanted spot (spot you want to delete) is light in color, click the [Repair (Light)] button and when it is dark in color, click the [Repair (Dark)] button.
   ➔ Move the cursor over the image and the correction range is displayed as [O].

5 Cover the unwanted spot in the image with the correction range [O] and click.
   ➔ The unwanted spot within the correction range is corrected.
   • If you then click on the image, the unwanted spots within the selected correction range are corrected.
   • To correct another section of the image, cancel the repair function by clicking the [Repair (Light)] button or the [Repair (Dark)] button, and perform the operation from step 3 again.

6 Click the [OK] button.

When sections of the image that cannot be corrected with the repair function have been selected, [x] is displayed.

In step 2, you can double-click on the section you want to correct to display the 100% view. You can also double-click again to return to the original view.

For information on shortcut keys, refer to the "Shortcut List" (p.5-3).
Copy Stamp
You can correct an image by pasting a section copied from another part of the same image to an unwanted part of the image.

1. Select the [Tools] menu > [Start Stamp tool].
   ➔ The copy stamp window appears.

2. Click the [100% view] button.
   ➔ The image is displayed in the 100% view.

3. Display the section you want to correct.
   ➔ Drag the image to display the section you want to correct.

4. Specify the section to copy.
   ➔ Click the [Select Copy Source] button and then click the section to copy.
   ➔ To change the copied section, repeat the above procedure.

5. Correct the image.
   ➔ Click or drag on the section you want to correct on the image. [+ ] in the window indicates the copy origin, and [ ] indicates the copy destination.
   ➔ The copied image is pasted in the position where you dragged.

6. Click the [OK] button.
   ➔ In step 2, you can double-click on the section you want to correct to display the 100% view. You can also double-click again to return to the original view.
   ➔ In step 4, you can also specify the section to copy by holding down the <option> key and clicking.
   ➔ For information on shortcut keys, refer to the “Shortcut List” (p.5-3).
Using Edits (Recipe Data)

Editing data that has been applied to RAW images (p.1-6 to p.1-9, p.2-3 to p.2-6) or editing data that has been applied to JPEG, TIFF, and RAW images (p.1-9 to p.1-12, p.2-6 to p.2-8) can be copied and applied to other images. Editing data can also be saved as a separate file containing editing data only and loaded into other images. In Digital Photo Professional, editing data is referred to as "recipe data".

Saving the Recipes

1. Select an image and then select [Edit] menu ➤ [Save recipe in file].
   ➔ The [Save] dialog box appears.

2. Select the destination folder, enter the file name, and then click the [Save] button.

   • When you select [Save recipe in file], only recipe data (editing data) is saved as a separate file. If you wish to save the image to which the edits were applied, see "Saving Edited Images" (p.1-14).
   • Image rotation (p.1-2), trimming (p.1-10) and image correction (repair, copy stamp) (p.1-11, p.1-12) are not included in recipe data.

Loading and Pasting Recipes

1. Select an image and then select [Edit] menu ➤ [Read recipe from file].
   ➔ The [Open] dialog box appears.

2. Select a recipe and click the [Open] button.

3. Select an image to which the recipe will be applied and then select [Edit] menu ➤ [Paste recipe to selected photo].

   • Editing data that can be performed on RAW images only (p.1-6 to p.1-9, p.2-3 to p.2-6) cannot be applied to JPEG and TIFF images. If you try to apply editing data that can be applied to all image types (JPEG, TIFF, or RAW images) (p.1-9 to p.1-12, p.2-6 to p.2-8) together with editing data that can be applied only to RAW images (p.1-6 to p.1-9, p.2-3 to p.2-6), and the target image is in JPEG or TIFF, only the editing data applicable to JPEG and TIFF is applied.
Reverting Edited Images to Their Original Condition

You can cancel all the edits for images, and revert the edited images to their original settings before being edited or when shots were taken.

**Reverting to Last Saved Settings**

Select an image and then select [Adjustment] menu ▶ [Revert to last saved settings].

- If you select multiple images, all the edited images that you selected are reverted to the last saved settings.

**Reverting to Shot Settings**

Select an image and then select [Adjustment] menu ▶ [Revert to shot settings].

- If you select multiple images, all the edited images that you selected are reverted to the shot settings.

**Saving Edited Images**

You can apply edits to one or more images and save the edited images.

**Saving by Overwriting**

You can apply edits to an image and overwrite the existing image.

Select an image and then select [File] menu ▶ [Add recipe and save].

**Saving and Renaming**

You can apply edits to images and save the new images with another name.

1. Select an image and then select [File] menu ▶ [Add recipe and save as].
   - The [Save as] dialog box appears.
2. Select the destination folder, enter the file name, and then click the [Save] button.

**Adding a Thumbnail of the Image**

You can create new thumbnails to use for display in the main window, and add to each image. The images will be displayed in the main window quicker and the quality of the images will increase.

Select the image and then select [File] menu ▶ [Add thumbnail to image and save].

- A large number of images may take some time to add.
Converting and Saving RAW Images while Renaming Them

You can convert edited RAW images to the TIFF or JPEG and save them with another name.

1. Select an image and then select [File] menu ➔ [Convert and save].
   → The [Convert and save] dialog box appears.

2. Specify the settings and click the [Save] button.

- Specify the drive or folder to which the image will be saved.
- Select an image type used when the image is saved.

<table>
<thead>
<tr>
<th>Image Type</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exif-JPEG</td>
<td>.JPG</td>
</tr>
<tr>
<td>Exif-TIFF 8bit</td>
<td>.TIF</td>
</tr>
<tr>
<td>TIFF 16bit</td>
<td>.TIF</td>
</tr>
</tbody>
</table>

- Specify a value between 1 and 60,000 dpi as the output resolution used for the image to be saved.
- Enter the name of the image to be saved.
- Displays the contents of the drive or folder.
- If you have selected [Exif-JPEG] in the [Kind of file] list box, set the image quality (compression rate) with a range of 1 to 10 by dragging the slider left or right. Higher values give better JPEG image quality.
- Check this checkbox to embed an ICC profile in the image to be saved.
- Check this checkbox to change the size of the image to be saved.
- Set the width of the image.
- Set the height of the image.
- Check this checkbox to fix the vertical/horizontal ratio of the image.
- Cans the unit of measurement.
- Cancels all settings and closes the window.

If you have saved an image in which [Wide Gamut RGB], [Apple RGB] or [ColorMatch RGB] color space (p.1-9, p.1-21) has been specified, an ICC Profile is automatically embedded even if you have not checked [Embed ICC profile].

You can save and rename images without editing them.

- [Resize setting] changes the image size by applying the larger numeric value set in “Width” or “Height” to the longer edge of the image, even when horizontal and vertical images are mixed together.
- When you have set the tone curve to [Linear] (p.2-6), select [TIFF 16bit] and save.

The specified preferences (p.1-21) or individually specified color space (p.1-9) are added to the ICC profile embedded in TIFF or JPEG images. An ICC profile contains color information, such as color properties and color spaces of devices which are authorized by International Color Consortium (ICC). With this ICC profile, many color management systems can minimize the color differences between devices.
Converting and Saving Images in a Single Operation (Batch-processing)

You can save and rename multiple edited images in a single operation. You can also convert edited RAW images to JPEG or TIFF and save them in a single operation.

1. **Edit an image** (p.1-6 to p.1-12).
2. **Select images to be converted and saved in a single operation**.
   - The [Batch process settings] dialog box appears.
   - Alternatively, you can display this dialog box by selecting [File] menu [Batch process].
3. **Specify the settings**.
4. **Click the [Execute] button**.
   - The processing window appears, allowing images to be saved in a single operation.
   - When processing is complete, the images are saved in the specified folder and the [Terminate] button appears on the processing window.
5. **Click the [Terminate] button**.
   - You cannot save multiple images in a single operation unless you specify [Sequence number] when the [New file name] is selected for [File name].
   - You can also save and rename multiple images without editing them in a single operation.
   - [Resize setting] changes the image size by applying the larger numeric value set in "Width" or "Height" to the longer edge of the image, even when horizontal and vertical images are mixed together.
   - The batch process function is independent of other functions. Therefore, during batch saving, you can perform other operations in the main, edit and edit image windows.
6. **Complete the batch processing**.
   - If you have saved an image in which [Wide Gamut RGB], [Apple RGB] or [ColorMatch RGB] color space (p.1-9, p.1-21) has been specified, an ICC Profile is automatically embedded even if you have not checked [Embed ICC profile].
   - The specified preferences (p.1-21) or individually specified color space (p.1-9) are added to the ICC profile embedded in TIFF or JPEG images. An ICC profile contains color information, such as color properties and color spaces of devices which are authorized by International Color Consortium (ICC). With this ICC profile, many color management systems can minimize the color differences between devices.
Changing File Names in a Single Operation

You can change file names in a single operation.

1. Select the images for which you want to change the file names.

2. Select the [Tools] menu ➤ [Start Rename tool].
   - The rename tool window appears.

3. Specify the settings and then click the [Execute] button.
   - The operation begins and the file names are changed.

Change File Names in a Single Operation

You can change file names in a single operation.

1. Select the images for which you want to change the file names.

2. Select the [Tools] menu ➤ [Start Rename tool].
   - The rename tool window appears.

3. Specify the settings and then click the [Execute] button.
   - The operation begins and the file names are changed.

Select an item to be set in the file name from each item.

- Selects the order of the files.
- Selects the extension.
- Makes the file names of simultaneously recorded RAW and JPEG images the same (except for the extension).
- Copies the image and changes the file name.
- When [Copy & Rename] is checked, specifies the save destination of the copied images.
- The original file names are displayed.
- The modified file names are displayed.
- Modifies the file names.
- Cancels all settings and closes the window.
Transferring Images to Image Editing Software

Transferring One Image to Photoshop

You can transfer an image to Adobe Photoshop.

1. **Select the image to transfer to Photoshop.**
2. **Select [Tools] menu → [Transfer to Photoshop].**
   - Photoshop starts up and displays the transferred image.
   - RAW images are converted to TIFF 16bit images before being transferred.

⚠️ In order to transfer images, you will need Adobe Photoshop.
⚠️ Compatible versions of Photoshop are CS and 7.0. You cannot transfer images to Photoshop Elements.
⚠️ One image can be transferred at a time. You cannot transfer multiple images at a time.
⚠️ When images are transferred, they are automatically converted to the TIFF 16bit images and the ICC profile is attached to each of them. The specified preferences (p.1-21) or individually specified work color space (p.1-9) information are added to the ICC profile, which allows Photoshop to display images including that color information.

Transferring Multiple Images to Image Editing Software

You can transfer multiple images to image editing software. The description given here uses Adobe Photoshop CS, as an example.

1. **Set convert/save in a single operation.**
   - Follow steps 1 to 4 of “Converting and Saving Images in a Single Operation (Batch-processing)” (p.1-16).
2. **Click [Browse] button in the [Batch process settings] window.**
   - The [Open] window appears.
3. **Select the image editing software (Photoshop CS) to which you will transfer the images.**
   - In the drive on which you installed Photoshop CS, select [Applications] folder → [Adobe Photoshop CS] folder → [Adobe Photoshop CS], and then click the [Open] button.
4. **Check the [Open image using software].**
5. **Click the [Execute] button.**
   - The processing window appears and saving in a single operation begins.
   - When saving in a single operation is completed, Photoshop starts up and the transferred images are displayed.

⚠️ In order to transfer images, you will need image editing software such as Adobe Photoshop.
Printing Images

Images can be automatically adjusted and printed within the print range.

1. Select an image and then select [File] menu ➔ [Print].
2. Select a printer to be used and then click the [Print] button.
   ➔ Printing begins.

- You can set a printer profile to be used for printing. You can select a rendering intent (matching method) when you have set the profile (p.1-21).
- If you have set CMYK simulation profile (p.1-21), the image is printed in a tone corresponding to the specified [CMYK simulation profile].

Printing with Easy-PhotoPrint

Easy-PhotoPrint is printing software dedicated for Canon BJ printers. If Easy-PhotoPrint 2.1 or later has been installed in your computer, you can print images with Easy-PhotoPrint.

1. Select an image and then select [File] menu ➔ [Print with Easy-PhotoPrint].
   ➔ Easy-PhotoPrint starts up.

- Follow the instructions displayed on the Easy-PhotoPrint window to print images.

- To print images with Easy-PhotoPrint, you need Easy-PhotoPrint 2.1 or later and a Canon BJ printer that supports Easy-PhotoPrint 2.1 or later.
- The specified output resolution (p.1-20) and trimming (p.1-10) are not supported.
- The setting of CMYK simulation (p.1-21) is not supported.

- You can set a rendering intent (matching method) when printing (p.1-21).

Displaying Images in EOS Capture

Digital Photo Professional version 2.0 is compatible with EOS Capture version 1.1 or later. If you have EOS Capture version 1.1 or later installed on your computer, Digital Photo Professional displays the images shot with EOS Capture.

1. Connect the camera to your computer and set the camera’s power switch to <ON>.
   ➔ When [CameraWindow] and other windows are displayed, close all the displayed windows.
2. Select [Tools] menu ➔ [Start EOS Capture].
   ➔ EOS Capture starts up.
3. Take a shot.
   ➔ Click the [Shoot] button in EOS Capture or press the shutter button on the camera to take a shot.
   ➔ The shot image is displayed in the Digital Photo Professional main window.

- When EOS Capture starts up, you can switch the Digital Photo Professional window automatically from the main window to the edit image window (p.1-20).
Specifying Preferences

You can specify various settings for Digital Photo Professional.

1. Select [Digital Photo Professional] menu ▶ [Preferences].
   → The [Preferences] dialog box appears.

2. Select the desired tab, specify the settings, and then click the [OK] button.
   → The settings are applied and the [Preferences] dialog box closes.

- Allows you to select whether the edited image is saved automatically or the confirmation dialog box is displayed, when you quit Digital Photo Professional or change images displayed in the main window to the ones in another folder.

- Allows you to specify the grid spacing in a range of 8 to 256 pixels used when the grid lines (p.2-3) are displayed in the edit window or the edit image window.

- Allows you to specify the grid spacing in a range of 8 to 256 pixels used when the grid lines (p.2-3) are displayed in the edit window or the edit image window.

- Allows you to set the output resolution default value from 1 to 60,000 dpi when RAW images are converted to JPEG or TIFF images and saved.

Specify the image quality for displaying or saving images.

- [Quality priority] : Images are displayed and saved with maximum quality because additional filter processings are applied. However, it takes more time to display or save images.
- [Standard] : Images are displayed at maximum speed with no additional filter processing. Images are saved at the same quality as [Quality priority].
- [Speed priority] : Images are displayed and saved at maximum speed because no additional filter processing is applied.

If you check this checkbox, an image opened in the edit window will appear selected in the main window.

Select the display mode for displaying the edited and original images for comparison in the edit or edit image window (p.2-3).
Allows you to select the histogram displayed in the [RGB image adjustment] tab sheet on the tool palette.

- Select [Tone curve mode] (tone curve display), [Interpolation method] (tie method) displayed in the [RGB image adjustment] tab sheet on the tool palette (p.2-7).

Allows you to select whether the tool palette is displayed as [Docking display] (within the window) or [Floating display] (another window).

Select a color space for the monitor. If you select the [Monitor profile], click the [Browse] button and select a profile for the used monitor.

- Select a work color space from 5 kinds of color space.
  - sRGB: Standard color space for Windows. Widely used for the standard color space of monitors, digital cameras, and scanners.
  - Adobe RGB: A wider color space than sRGB. Mainly used for printing for business purposes.
  - Wide Gamut RGB: A wider color space than Adobe RGB.
  - Apple RGB: Standard color space for Macintosh. A slightly wider color space than sRGB.
  - ColorMatch RGB: A slightly wider color space than sRGB. Mainly used for printing for business purposes.

You can select a rendering intent (matching method) from [Perceptual] or [Colorimetric] for color conversion when printing an image.

- Perceptual: Matching method generally suited to natural images such as photographs which minutely expresses intermediate colors such as skin tones and the blue of the sky.
- Colorimetric: Matching method generally suited to graphic-type images such as photographs which expresses an image in the vivid primary colors of red, blue and yellow.

With [CMYK simulation profile], you can simulate the color used when you print in a CMYK environment such as that of a printer. Digital Photo Professional is compatible with the following 4 types of printing profiles.

- Euro Standard v1.00: Profile normally used for book printing in Europe, suitable for simulation of standard European printing.
- JMPA v1.10: Profile normally used for book printing, etc. in Japan, suitable for simulation of magazine advertising standard color printing.
- U.S. Web Coated v1.00: Profile normally used for book printing in North America, suitable for simulation of North American standard printing.
- JapanColor2001 type3: Profile becoming a standard in the Japanese printing industry, suitable for simulation of JapanColor standard printing.

When you restart Digital Photo Professional after changing [Default settings of RGB Tone curve mode] in the [Tool palette] tab sheet or [Default settings of Work color space] in the [Color management] tab sheet, the setting content is applied. However, the setting content is not applied to an image which has been edited before a change was made (p.1-9 to p.1-12, p.2-6 to p.2-8) and which has a [RGB] mark displayed (p.1-3). Change an individual tone curve with the menu (p.2-7) that appears by clicking on the tone curve while holding down the <control> key, an individual color space by selecting the [Adjustment] menu > [Work color space] (p.1-9).

To select a monitor or printer profile, you need to have previously installed the monitor and printer profiles to be used on the computer. For details on the monitor and printer profiles to be used, refer to the user manual of each device.

The specified color space is added to the ICC profile that is embedded in TIFF or JPEG images that have been converted from RAW images and saved (p.1-15, p.1-16).

A color space is the reproducible color range (the characteristics of color gamut). Digital Photo Professional supports the following 5 kinds of color space.

- sRGB: Standard color space for Windows. Widely used for the standard color space of monitors, digital cameras, and scanners.
- Adobe RGB: A wider color space than sRGB. Mainly used for printing for business purposes.
- Wide Gamut RGB: A wider color space than Adobe RGB.
- Apple RGB: Standard color space for Macintosh. A slightly wider color space than sRGB.
- ColorMatch RGB: A slightly wider color space than sRGB. Mainly used for printing for business purposes.

To select a monitor or printer profile, you need to have previously installed the monitor and printer profiles to be used on the computer. For details on the monitor and printer profiles to be used, refer to the user manual of each device.

You can select a rendering intent (matching method) from [Perceptual] or [Colorimetric] for color conversion when printing an image.

- Perceptual: Matching method generally suited to natural images such as photographs which minutely expresses intermediate colors such as skin tones and the blue of the sky.
- Colorimetric: Matching method generally suited to graphic-type images such as photographs which expresses an image in the vivid primary colors of red, blue and yellow.

With [CMYK simulation profile], you can simulate the color used when you print in a CMYK environment such as that of a printer. Digital Photo Professional is compatible with the following 4 types of printing profiles.

- Euro Standard v1.00: Profile normally used for book printing in Europe, suitable for simulation of standard European printing.
- JMPA v1.10: Profile normally used for book printing, etc. in Japan, suitable for simulation of magazine advertising standard color printing.
- U.S. Web Coated v1.00: Profile normally used for book printing in North America, suitable for simulation of North American standard printing.
- JapanColor2001 type3: Profile becoming a standard in the Japanese printing industry, suitable for simulation of JapanColor standard printing.

You can select a rendering intent (matching method) from [Perceptual] or [Colorimetric] for color conversion when printing an image.

- Perceptual: Matching method generally suited to natural images such as photographs which minutely expresses intermediate colors such as skin tones and the blue of the sky.
- Colorimetric: Matching method generally suited to graphic-type images such as photographs which expresses an image in the vivid primary colors of red, blue and yellow.

With [CMYK simulation profile], you can simulate the color used when you print in a CMYK environment such as that of a printer. Digital Photo Professional is compatible with the following 4 types of printing profiles.

- Euro Standard v1.00: Profile normally used for book printing in Europe, suitable for simulation of standard European printing.
- JMPA v1.10: Profile normally used for book printing, etc. in Japan, suitable for simulation of magazine advertising standard color printing.
- U.S. Web Coated v1.00: Profile normally used for book printing in North America, suitable for simulation of North American standard printing.
- JapanColor2001 type3: Profile becoming a standard in the Japanese printing industry, suitable for simulation of JapanColor standard printing.

You can select a rendering intent (matching method) from [Perceptual] or [Colorimetric] for color conversion when printing an image.

- Perceptual: Matching method generally suited to natural images such as photographs which minutely expresses intermediate colors such as skin tones and the blue of the sky.
- Colorimetric: Matching method generally suited to graphic-type images such as photographs which expresses an image in the vivid primary colors of red, blue and yellow.

With [CMYK simulation profile], you can simulate the color used when you print in a CMYK environment such as that of a printer. Digital Photo Professional is compatible with the following 4 types of printing profiles.

- Euro Standard v1.00: Profile normally used for book printing in Europe, suitable for simulation of standard European printing.
- JMPA v1.10: Profile normally used for book printing, etc. in Japan, suitable for simulation of magazine advertising standard color printing.
- U.S. Web Coated v1.00: Profile normally used for book printing in North America, suitable for simulation of North American standard printing.
- JapanColor2001 type3: Profile becoming a standard in the Japanese printing industry, suitable for simulation of JapanColor standard printing.

You can select a rendering intent (matching method) from [Perceptual] or [Colorimetric] for color conversion when printing an image.

- Perceptual: Matching method generally suited to natural images such as photographs which minutely expresses intermediate colors such as skin tones and the blue of the sky.
- Colorimetric: Matching method generally suited to graphic-type images such as photographs which expresses an image in the vivid primary colors of red, blue and yellow.

With [CMYK simulation profile], you can simulate the color used when you print in a CMYK environment such as that of a printer. Digital Photo Professional is compatible with the following 4 types of printing profiles.

- Euro Standard v1.00: Profile normally used for book printing in Europe, suitable for simulation of standard European printing.
- JMPA v1.10: Profile normally used for book printing, etc. in Japan, suitable for simulation of magazine advertising standard color printing.
- U.S. Web Coated v1.00: Profile normally used for book printing in North America, suitable for simulation of North American standard printing.
- JapanColor2001 type3: Profile becoming a standard in the Japanese printing industry, suitable for simulation of JapanColor standard printing.

You can select a rendering intent (matching method) from [Perceptual] or [Colorimetric] for color conversion when printing an image.

- Perceptual: Matching method generally suited to natural images such as photographs which minutely expresses intermediate colors such as skin tones and the blue of the sky.
- Colorimetric: Matching method generally suited to graphic-type images such as photographs which expresses an image in the vivid primary colors of red, blue and yellow.

With [CMYK simulation profile], you can simulate the color used when you print in a CMYK environment such as that of a printer. Digital Photo Professional is compatible with the following 4 types of printing profiles.

- Euro Standard v1.00: Profile normally used for book printing in Europe, suitable for simulation of standard European printing.
- JMPA v1.10: Profile normally used for book printing, etc. in Japan, suitable for simulation of magazine advertising standard color printing.
- U.S. Web Coated v1.00: Profile normally used for book printing in North America, suitable for simulation of North American standard printing.
- JapanColor2001 type3: Profile becoming a standard in the Japanese printing industry, suitable for simulation of JapanColor standard printing.

You can select a rendering intent (matching method) from [Perceptual] or [Colorimetric] for color conversion when printing an image.

- Perceptual: Matching method generally suited to natural images such as photographs which minutely expresses intermediate colors such as skin tones and the blue of the sky.
- Colorimetric: Matching method generally suited to graphic-type images such as photographs which expresses an image in the vivid primary colors of red, blue and yellow.

With [CMYK simulation profile], you can simulate the color used when you print in a CMYK environment such as that of a printer. Digital Photo Professional is compatible with the following 4 types of printing profiles.

- Euro Standard v1.00: Profile normally used for book printing in Europe, suitable for simulation of standard European printing.
- JMPA v1.10: Profile normally used for book printing, etc. in Japan, suitable for simulation of magazine advertising standard color printing.
- U.S. Web Coated v1.00: Profile normally used for book printing in North America, suitable for simulation of North American standard printing.
- JapanColor2001 type3: Profile becoming a standard in the Japanese printing industry, suitable for simulation of JapanColor standard printing.

You can select a rendering intent (matching method) from [Perceptual] or [Colorimetric] for color conversion when printing an image.

- Perceptual: Matching method generally suited to natural images such as photographs which minutely expresses intermediate colors such as skin tones and the blue of the sky.
- Colorimetric: Matching method generally suited to graphic-type images such as photographs which expresses an image in the vivid primary colors of red, blue and yellow.

With [CMYK simulation profile], you can simulate the color used when you print in a CMYK environment such as that of a printer. Digital Photo Professional is compatible with the following 4 types of printing profiles.

- Euro Standard v1.00: Profile normally used for book printing in Europe, suitable for simulation of standard European printing.
- JMPA v1.10: Profile normally used for book printing, etc. in Japan, suitable for simulation of magazine advertising standard color printing.
- U.S. Web Coated v1.00: Profile normally used for book printing in North America, suitable for simulation of North American standard printing.
- JapanColor2001 type3: Profile becoming a standard in the Japanese printing industry, suitable for simulation of JapanColor standard printing.
This chapter describes the functions of the edit window, and how to display images and perform detailed edits on them.

This chapter describes the functions that you can operate in the edit window only. For instructions on operating the functions common to those in the main window, refer to the page described with each item.
Displaying the Edit Window

You can enlarge a single image and perform detailed edits on it in the edit window. You can display multiple edit windows and edit them while comparing each of them (up to 36 images can be displayed).

This chapter describes the functions that you can operate in the edit window only.

For instructions on operating the functions common to those in the main window, refer to the page described with each item.

Double-click a thumbnail image in the main window.

- The edit window appears.
- A low resolution image is displayed first in the edit window, and then it switches to a high resolution image.
- Alternatively, you can display this window by selecting [File] menu ➔ [Open in Edit window].

Menu bar
Displays the [Digital Photo Professional], [File], [Edit], [View], [Adjustment], [Tools] and [Window] menus.

Image display area
Displays the coordinates of the cursor position and the RGB values (8-bit conversion) of an image.

Edit Window
The path for the image and file name are displayed.

Tool palette
RAW image adjustment tab sheet (p.2-3)
RGB image adjustment tab sheet (p.2-6)

Displays the operation mode (p.1-20).
Displays the color space (RAW is displayed for RAW images) of the image and the work color space (p.1-9, p.1-21).

If you set CMYK simulation profile (p.1-21), [CMYK] is displayed.
The CMYK simulation display can be canceled temporarily by holding down the <space> key on the keyboard.

If you set the tool palette to [Docking display] (p.1-21) and make the edit window large, a thumbnail of the image will be displayed. (When the tool palette is set to [Floating display] (p.1-21), the thumbnail image is always displayed.) The enlarged display position is displayed on the thumbnail and you can move the display position by dragging.

To display or hide the tool palette, select the [View] menu ➔ [Tool palette].
To quit the edit window, select [File] menu ➔ [Close Window].

For some images, it may take some time to switch to the high resolution image.

- You can select whether the tool palette is displayed as another window or displayed within the same window (p.1-21).
- For information on shortcut keys, refer to the “Shortcut List” (p.5-2).
Selecting the Image Display Mode

You can change the size and method in which images are displayed.

Selecting the Display Size

You can select the image size from [Fit to window] (Fitting to the image display area), [50% view], [100% view] (actual pixel size), and [200% view].

Select [View] menu ➔ Select the size to be set.

- The image is displayed in the selected size.
- When you display an image in a larger size, you can change the display position by dragging the image.

In the [Fit to window] display, if you double-click a section you want to enlarge, the display changes to the [100% view] display. If you double-click on the image in the [50% view], [100% view] or [200% view] display, the display changes to the [Fit to window] display.

Displaying the Grid Lines

You can display grid lines that allow you to check the horizontal or vertical level of the image.

Select [View] menu ➔ [Grid lines].

- Grid lines are displayed on the image.
- Performing the same operation again hides the grid lines.

You can specify the grid spacing (p.1-20).

Displaying the Edited Image and the Original at the Same Time

You can display the edited image and the original at the same time.

Select [View] menu ➔ [Before/after comparison].

- A split window with the image before and after editing is displayed.

The way the image is displayed can be changed (p.1-20).

Changing the Display Position

You can also tile images vertically.

Select [View] menu ➔ [Change up/down/left/right].

- Performing the same operation again tiles images horizontally.

Editing RAW Images

You can perform more detailed edits on RAW images that are supported by Digital Photo Professional, than in the main window. With RAW image editing (p.2-3 to p.2-6), there is hardly any of the deterioration which accompanies image editing. You can therefore edit an image multiple times while preserving the image quality at the time the image was shot.

1. Display the RAW image in the edit window (p.2-2).
   - When multiple images are displayed, click the image for which you wish to edit to place it in the top window.

2. Select the [RAW image adjustment] tab on the tool palette.
   - The [RAW image adjustment] tab sheet appears.

3. Edit the RAW images (p.2-3 to p.2-6).
   - You can apply edits to other images by copying and pasting the edit data to the other images (p.1-13).
   - You can revert edited images to the last saved settings or shot settings (p.1-14).

4. Compare the edited image with the original (see left).

5. Save the edited image (p.1-14).
   - You cannot edit PowerShot Pro1 RAW images.
   - Before quitting Digital Photo Professional, you must save the edited images (p.1-14).
   - The editing data can be saved in a separate file (p.1-13).

Adjusting the Brightness

You can adjust the brightness in the range of –2.0 to +2.0 (in 0.01-stop increments when entering a value).

Adjust an image while viewing it.

Drag the slider left or right to adjust the brightness. Restores the image to its original settings.

Enter a value to adjust the brightness.
Adjusting the White Balance
You can set the white balance with each method.

Selecting the White Balance (p.1-7)
You can set the white balance.

Specifying the Color Temperature (p.1-7)
You can specify the color temperature in the range of 2800 to 10000K (in 100K increments).

Click White Balance Function
Makes white the standard for the point you selected and color in the image is adjusted.

1 Click the [Click] button.
   ➔ When you move the cursor over the image, the cursor ( ] changes to ( ]).

2 Click the point where is to be the standard.
   ➔ The color in the image is adjusted with white as the standard on the point you selected.
   • If you click on another point over the image, the white balance is adjusted again.
   • When you finish this operation, click the [Click] button.

   ➔ The image is adjusted based on the average value of the range of 5 × 5 pixels from the clicked point.
   • Even if you have selected a neutral gray point of the image, the result of adjustments is the same as when you select a white point.

Adjusting with the Color Wheel (p.1-8)
You can select a desired color from the color wheel. You can also specify the hue in the range of 0 to 359 (in 1-stop increments), and the saturation in the range of 0 to 255 (in 1-stop increments).

Registering Adjusted White Balance (Personal White Balance)
You can register up to 3 adjusted white balance data as personal white balance settings.

1 Adjust the white balance.

2 Click the [Register] button.
   ➔ The [Register personal white balance] dialog box appears.

3 Select the number of the button to be registered from the list.

4 Click the [OK] button.

Personal White Balance (p.1-8)
You can apply the registered personal white balance to images.
Setting Picture Style

Selecting a Picture Style
You can set the Picture Style.

Select a Picture Style from the list box.

<table>
<thead>
<tr>
<th>Picture Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>The image looks vivid, sharp, and crisp.</td>
</tr>
<tr>
<td>Landscape</td>
<td>For vivid blues and greens, and very sharp and crisp images.</td>
</tr>
<tr>
<td>Portrait</td>
<td>For nice skin tones. The image looks slightly sharp and crisp. By changing the [Hue] (p.2-6), you can adjust the skin tone.</td>
</tr>
<tr>
<td>Neutral</td>
<td>For natural colors and subdued images. No sharpness is applied.</td>
</tr>
<tr>
<td>Faithful</td>
<td>When the subject is photographed under a color temperature of 5200K, the color is adjusted colorimetrically to match the subject’s color. No sharpness is applied.</td>
</tr>
<tr>
<td>B/W</td>
<td>For black-and-white images.</td>
</tr>
<tr>
<td>(Picture Style file set in the camera)</td>
<td>Displayed when selecting an image shot with Picture Style file set in the camera. In the list, the caption name of the Picture Style file set in the camera is displayed with ( ) attached.</td>
</tr>
<tr>
<td>[loaded Picture Style file]</td>
<td>The Picture Style file loaded by clicking the [Browse] button is applied. In the list, the caption name of the Picture Style file loaded by clicking the [Browse] button is displayed with [ ] attached.</td>
</tr>
</tbody>
</table>

Applying a Picture Style file
You can load and apply to images Picture Style files downloaded from Canon’s web site and saved on your computer.

1. Click the [Browse] button. → The [Open] window is displayed.

2. Select a Picture Style file and click the [Open] button. → The Picture Style file is loaded.

3. Select loaded Picture Style file from the list box. → The loaded Picture Style file is applied to the image.

A Picture Style file is a file that expands the Picture Style function. For detailed information on Picture Style files, refer to Canon’s web site.

Adjusting the Shadow and Highlight Points
You can specify the shadow point (the darkest point) and highlight point (the brightest point) to adjust the gradation of images.

Adjust an image while viewing it.

When you move the cursor to the left edge of the graph, the cursor [ ] changes to [←]. Drag the slider right to adjust the shadow point.

When you move the cursor to the right edge of the graph, the cursor [ ] changes to [→]. Drag the slider left to adjust the highlight point.

Selecting a Picture Style
You can set the Picture Style.

Select a Picture Style from the list box.

<table>
<thead>
<tr>
<th>Picture Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>The image looks vivid, sharp, and crisp.</td>
</tr>
<tr>
<td>Landscape</td>
<td>For vivid blues and greens, and very sharp and crisp images.</td>
</tr>
<tr>
<td>Portrait</td>
<td>For nice skin tones. The image looks slightly sharp and crisp. By changing the [Hue] (p.2-6), you can adjust the skin tone.</td>
</tr>
<tr>
<td>Neutral</td>
<td>For natural colors and subdued images. No sharpness is applied.</td>
</tr>
<tr>
<td>Faithful</td>
<td>When the subject is photographed under a color temperature of 5200K, the color is adjusted colorimetrically to match the subject’s color. No sharpness is applied.</td>
</tr>
<tr>
<td>B/W</td>
<td>For black-and-white images.</td>
</tr>
<tr>
<td>(Picture Style file set in the camera)</td>
<td>Displayed when selecting an image shot with Picture Style file set in the camera. In the list, the caption name of the Picture Style file set in the camera is displayed with ( ) attached.</td>
</tr>
<tr>
<td>[loaded Picture Style file]</td>
<td>The Picture Style file loaded by clicking the [Browse] button is applied. In the list, the caption name of the Picture Style file loaded by clicking the [Browse] button is displayed with [ ] attached.</td>
</tr>
</tbody>
</table>
Selecting the Tone Curve

You can select the tone curve.

Select a tone curve while viewing the image.

[Image of tone curve slider]

You can select [Linear] when you wish to adjust the image separately in image editing software such as Photoshop.

Adjusting the Hue, Saturation and Sharpness

The hue and saturation can be adjusted in the range of -4 to +4 (in 1-step increments), and sharpness in the range of 0 to 10 (in 1-step increments).

Also, when [B/W] is selected from the [Picture Style] list box (p.2-5), you can select from 5 types of [Filter effect] displayed ([None], [Yellow], [Orange], [Red], [Green]), and 5 types of [Toning effect] ([None], [Sepia], [Blue], [Purple], [Green]).

Adjust an image while viewing it.

[Image of hue, saturation, and sharpness adjustment sliders]

The set numerical value is displayed.

Editing Images

You can perform various edits on the RAW, JPEG, and TIFF images that are supported by Digital Photo Professional.

1. Display the image in the edit window (p.2-2).
   - When multiple images are displayed, click the image for which you wish to edit to place it on the top window.
2. Select the [RGB image adjustment] tab on the tool palette.
   - The [RGB image adjustment] tab sheet appears.
3. Edit the image (p.2-7, p.2-8).
   - You can apply edits to other images by copying and pasting the edit data to the other images (p.1-13).
   - You can revert edited images to the last saved settings or shot settings (p.1-14).
4. Compare the edited image with the original (p.2-3).
5. Save the edited image (p.1-14).
   - Before quitting Digital Photo Professional, you must save the edited images (p.1-14).
   - The editing data can be saved in a separate file (p.1-13).
Adjusting the Tone Curve

A tone curve shows the brightness and color saturation for the original image (input) and the adjusted image (output) in the form of a line graph. You can use the tone curve to adjust the image brightness and color saturation values that were set by the camera automatically when the shot was taken. Also, you can adjust the input and output of [R] (Red), [G] (Green) and [B] (Blue). The horizontal axis shows the brightness and color saturation for the original image (input), with the left-hand end indicating shadow (darker areas of the image) and the right-hand end indicating highlights (brighter areas of the image). The vertical axis shows the brightness and color saturation for the adjusted image (output), with the lower end indicating shadow and the upper end indicating highlights.

Adjusting the Tone Curve

1. Click the button to select a channel.

   - The same settings are applied to all RGB channels.
   - The settings are applied to the B channel.
   - The settings are applied to the G channel.
   - The settings are applied to the R channel.

2. Adjust the tone curve.

   - Clicking the tone curve shows [ ] on the tone curve. Drag [ ] to your desired location.
   - You can specify up to 8 points of [ ]:
   - Double-clicking [ ] deletes it.

   Enter a value to specify the maximum output.

   Enter a value to specify the minimum output.

   Enter a value in the range of 0 to 247 (in 1-stop increments) to adjust the shadow point.

   Enter a value in the range of 8 to 255 (in 1-stop increments) to adjust the highlight point.

   Enter a value in the range of 8 to 255 (in 1-stop increments) to adjust the highlight point in the output side.

   Horizontal axis: Input level
   Vertical axis: Output level

   When you move the cursor to the top of the graph, [ ] changes to [ ].
   Drag it downward to adjust the highlight point in the output side.

   When you move the cursor to the bottom of the graph, [ ] changes to [ ].
   Drag it upward to adjust the shadow point in the output side.

   When you move the cursor to the right edge of the graph, the cursor [ ] changes to [ ].
   Drag the slider left to adjust the highlight point.

   When you move the cursor to the left edge of the graph, the cursor [ ] changes to [ ].
   Drag the slider right to adjust the shadow point.

   Enter a value in the range of 0 to 247 (in 1-stop increments) to adjust the shadow point.

   The minimum number of steps between the shadow point and the highlight point is 8.

   You can change the tone curve interpolation method (Curve/Straight) or tone curve modes (RGB R G B/Luminance R G B) from the menu that appears by clicking on a tone curve while holding down <control> key, or from the [Tool palette] tab sheet in the [Preferences] dialog box (p.1-21).
Click White Balance Function
Makes white the standard for the point you selected and color in the image is adjusted.

1 Click the [Click] button.
   ➔ When you move the cursor over the image, the cursor \[ \] changes to \[ \].

2 Click the point where is to be the standard.
   ➔ The color in the image is adjusted with white as the standard on the point you selected.
   ➔ If you click on another point over the image, the white balance is adjusted again.
   ➔ When you finish this operation, click the [Click] button.

   ➔ The image is adjusted based on the value of 1 X 1 pixels from the clicked point.
   ➔ Even if you have selected a neutral gray point of the image, the result of adjustments is the same as when you select a white point.

Adjusting the Luminance and Contrast
You can adjust the luminance and contrast in the range of –100 to +100 (in 1-stop increments when entering a value).

Adjust an image while viewing it.
Drag the slider left or right to adjust the luminance and contrast.

Adjusting the Hue, Saturation and Sharpness
You can adjust the hue in the range of –30 to +30 (in 1-step increments when entering a value), the saturation in the range of 0 to 200 (in 1-step increments when entering a value) and the sharpness in the range of 0 to 500 (in 1-step increments when entering a value).

Adjust an image while viewing it.
Drag the slider left or right to adjust the hue, saturation sharpness.

Enter a value to adjust the hue, saturation sharpness.

Enter a value to adjust the luminance and contrast.

Restores the image to its original settings.
Performing Detailed Edits in the Edit Image Window

In the edit image window, you can select one image from multiple images and perform detailed edits on the selected image.

- The functions of the edit image window are the same as those of the main window (chapter 1) and of the edit window (chapter 2). For detailed instructions on operating these functions, refer to the page described with each item.

1. **Select multiple images in the main window.**

2. **Click the [Edit image window] button.**
   - The main window switches to the edit image window.
   - The image clicked in the thumbnail image display area is displayed in the image display area.
   - A low resolution image is displayed first, and then it switches to a high resolution image.
   - Alternatively, you can display this window by selecting [View] menu ➤ [Edit in Edit image window].

   - The path for the image and file name are displayed.
   - Displays grid lines on the selected image.
   - Scales down the image 50%.
   - When you display an image in a larger size, you can change the display position by dragging the image.
   - Displays the operation mode (p.1-20).
   - Displays the coordinates of the cursor position and the RGB values (8-bit conversion) of an image.
   - The edit image window switches to the main window.
   - Shows/hides the thumbnail image display area.
   - Shows/hides the tool palette.
   - Shows/hides the thumbnail image display area.
   - When you display an image in a larger size, you can change the display position by dragging the image.

   - Displays the color space ([RAW] is displayed for RAW images) of the image and the work color space (p.1-9, p.1-21).
   - When you set CMYK simulation profile (p.1-21), [CMYK] is displayed. The CMYK simulation display can be canceled temporarily by holding down the <space> key on the keyboard.

   - You can select whether the tool palette is displayed as another window or displayed within the same window (p.1-21).
   - For information on shortcut keys, refer to the "Shortcut List" (p.5-3).
4 Displaying an Image in the Quick Check Window

In the quick check window, enlarged images are displayed and they can be quickly viewed and checked.

1 Select multiple images in the main window.

2 Select the [Tool] menu » [Start Quick check tool].
   ➔ The quick check window appears.

3 View and check the images.

4 Click the [OK] button.

   - Displays a set check mark number.
   - Displays the image display area.
   - The path for the image and file name are displayed.
   - Scales down the image 50%.
     If you have set [50% view], you can change the display position of an image by dragging the image.
   - Displays the full screen.
     To return to the original view, click this button again.
     To switch between full screen display/normal screen display, press the <Ctrl> + <F11> keys on the keyboard.
   - Selects and sets a number from 3 types of check marks.
   - Removes all the check marks.
   - Rotates the image 90° to the left or right.
   - Displays the next image.
   - Displays the previous image.
   - Applies specified settings to the image and closes the quick check window.

- You can also specify each setting or switch between full screen/normal screen from the menu that appears by clicking on the window while holding down the <control> key.
- For information on shortcut keys, refer to the "Shortcut List" (p.5-2).
This chapter provides troubleshooting, the instructions on uninstalling Digital Photo Professional, and shortcut key list to allow you to use Digital Photo Professional easily.

Troubleshooting

If you could not complete the installation correctly, Digital Photo Professional does not work, or could not display images with Digital Photo Professional, consult the items described below.

Installation failed.

- Are you logged into an account other than the Administrator account?
  - You cannot install software unless you are logged into an account with Administrator privileges. Log in again into an account with Administrator privileges.
  - For how to log in and how to specify Administrator settings, refer to the User’s Manual for the Macintosh computer you are using or for OS X.

Digital Photo Professional does not work.

- Does your computer meet the system requirements for Digital Photo Professional?
  - Check the system requirements (p.0-2).

- Is there enough RAM (memory)?
  - Check the system requirements (p.0-2).

- Is the screen resolution less than [1024 × 768]?
  - Specify [1024 × 768] or more for the screen resolution (p.0-2).

- Is the color less than [Thousands]?
  - Specify [Thousands] or more for the color (p.0-2).

- Are multiple applications running?
  - Quit any applications other than Digital Photo Professional. Even if your computer has the RAM capacity (memory) described in system requirements (p.0-2), if other application is running at the same time as Digital Photo Professional, you may not have sufficient RAM (memory).

- Is the preferences file for Digital Photo Professional corrupted?
  - The preferences file for Digital Photo Professional may be damaged. Quit any applications that are running, delete the preferences file from the [Preferences] folder using the following procedure, and then restart Digital Photo Professional.
    - Open the hard disk drive where the system is saved ► the [Users] folder ► Folder for the logged in user ► the [Library] folder ► the [Preferences] folder and then delete [com.canon.Digital Photo Professional.plist].
    - For Macintosh operating systems OS X 10.2, double-click the startup disk ► click the [Home] button ► the [Library] folder to open the [Preferences] folder and delete [com.canon.Digital Photo Professional.plist].

Could not display images with Digital Photo Professional.

- Did you try to display images other than the image types that are supported by Digital Photo Professional?
  - Check the supported images (p.0-2).

Uninstalling the Software

- Log into the account used when installation was performed.
- Quit any applications before uninstalling Digital Photo Professional.
- When you have moved the folders to be deleted to the Trash, select [Finder] menu ► [Empty Trash] to empty the Trash. You cannot reinstall Digital Photo Professional until you have emptied the Trash.

1. Display the folder containing the [Digital Photo Professional] folder.
   - Open the [Canon Utilities] folder.


   - The [Digital Photo Professional] folder is deleted.
   - When uninstallation ends, restart your computer.

You cannot retrieve data that you have emptied into the Trash and deleted, so be particularly careful when deleting data.
# Shortcut Key List

## Main Window

<table>
<thead>
<tr>
<th>Operation</th>
<th>Key</th>
<th>Operation</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences</td>
<td>⌘ + ,</td>
<td>Select RAW photos only</td>
<td>option + ⌘ + A</td>
</tr>
<tr>
<td>Hide Digital Photo Professional</td>
<td>⌘ + H</td>
<td>Select check mark1 photos only</td>
<td>option + ⌘ + 1</td>
</tr>
<tr>
<td>Hide Others</td>
<td>option + ⌘ + H</td>
<td>Select check mark2 photos only</td>
<td>option + ⌘ + 2</td>
</tr>
<tr>
<td>Quit Digital Photo Professional</td>
<td>⌘ + Q</td>
<td>Select check mark3 photos only</td>
<td>option + ⌘ + 3</td>
</tr>
<tr>
<td>Open in Edit window</td>
<td>⌘ + O</td>
<td>Copy recipe to clipboard</td>
<td>option + ⌘ + C</td>
</tr>
<tr>
<td>Open Window</td>
<td>⌘ + N</td>
<td>Paste recipe to selected photo</td>
<td>option + ⌘ + C</td>
</tr>
<tr>
<td>Close window</td>
<td>⌘ + W</td>
<td>Edit in Edit image window</td>
<td>⌘ + →</td>
</tr>
<tr>
<td>Add recipe and save</td>
<td>⌘ + S</td>
<td>Large thumbnail</td>
<td>⌘ + 1</td>
</tr>
<tr>
<td>Add recipe and save as</td>
<td>shift + ⌘ + S</td>
<td>Middle thumbnail</td>
<td>⌘ + 2</td>
</tr>
<tr>
<td>Add thumbnail to image and save</td>
<td>shift + ⌘ + T</td>
<td>Small thumbnail</td>
<td>⌘ + 3</td>
</tr>
<tr>
<td>Convert and save</td>
<td>⌘ + D</td>
<td>Thumbnail with information</td>
<td>⌘ + 4</td>
</tr>
<tr>
<td>Batch process</td>
<td>⌘ + B</td>
<td>Rotate left</td>
<td>⌘ + L</td>
</tr>
<tr>
<td>Create New Folder</td>
<td>shift + ⌘ + N</td>
<td>Rotate right</td>
<td>⌘ + R</td>
</tr>
<tr>
<td>Page setup</td>
<td>shift + ⌘ + P</td>
<td>Add check mark1</td>
<td>⌘ + F1</td>
</tr>
<tr>
<td>Print</td>
<td>⌘ + P</td>
<td>Add check mark2</td>
<td>⌘ + F2</td>
</tr>
<tr>
<td>Print with Easy-PhotoPrint</td>
<td>⌘ + E</td>
<td>Add check mark3</td>
<td>⌘ + F3</td>
</tr>
<tr>
<td>Delete</td>
<td>⌘ + delete</td>
<td>Remove check mark</td>
<td>⌘ + F4</td>
</tr>
<tr>
<td>Info display</td>
<td>⌘ + I</td>
<td>Start Quick check tool</td>
<td>option + ⌘ + F</td>
</tr>
<tr>
<td>Copy</td>
<td>⌘ + C</td>
<td>Start Trimming tool</td>
<td>option + ⌘ + T</td>
</tr>
<tr>
<td>Paste</td>
<td>⌘ + V</td>
<td>Start Stamp tool</td>
<td>option + ⌘ + S</td>
</tr>
<tr>
<td>Select all</td>
<td>⌘ + A</td>
<td>Start Rename tool</td>
<td>option + ⌘ + R</td>
</tr>
<tr>
<td>Clear all</td>
<td>shift + ⌘ + A</td>
<td>Minimize Window</td>
<td>⌘ + M</td>
</tr>
</tbody>
</table>

## Edit Window

<table>
<thead>
<tr>
<th>Operation</th>
<th>Key</th>
<th>Operation</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences</td>
<td>⌘ + ,</td>
<td>Fit to window</td>
<td>⌘ + 4</td>
</tr>
<tr>
<td>Hide Digital Photo Professional</td>
<td>⌘ + H</td>
<td>50% view</td>
<td>⌘ + 1</td>
</tr>
<tr>
<td>Hide Others</td>
<td>option + ⌘ + H</td>
<td>100% view</td>
<td>⌘ + 2</td>
</tr>
<tr>
<td>Quit Digital Photo Professional</td>
<td>⌘ + Q</td>
<td>200% view</td>
<td>⌘ + 3</td>
</tr>
<tr>
<td>Close Window</td>
<td>⌘ + W</td>
<td>Rotate left</td>
<td>⌘ + L</td>
</tr>
<tr>
<td>Add recipe and save</td>
<td>⌘ + S</td>
<td>Rotate right</td>
<td>⌘ + R</td>
</tr>
<tr>
<td>Add recipe and save as</td>
<td>shift + ⌘ + S</td>
<td>Add check mark1</td>
<td>⌘ + F1</td>
</tr>
<tr>
<td>Convert and save</td>
<td>⌘ + D</td>
<td>Add check mark2</td>
<td>⌘ + F2</td>
</tr>
<tr>
<td>Page setup</td>
<td>shift + ⌘ + P</td>
<td>Add check mark3</td>
<td>⌘ + F3</td>
</tr>
<tr>
<td>Print</td>
<td>⌘ + P</td>
<td>Remove check mark</td>
<td>⌘ + F4</td>
</tr>
<tr>
<td>Info display</td>
<td>⌘ + I</td>
<td>Start Trimming tool</td>
<td>option + ⌘ + T</td>
</tr>
<tr>
<td>Copy</td>
<td>⌘ + C</td>
<td>Start Stamp tool</td>
<td>option + ⌘ + S</td>
</tr>
<tr>
<td>Paste</td>
<td>⌘ + V</td>
<td>Minimize Window</td>
<td>⌘ + M</td>
</tr>
<tr>
<td>Show/hide Tool palette</td>
<td>⌘ + T</td>
<td>Cancel CMYK simulation (only functions while holding down the key)</td>
<td>space</td>
</tr>
</tbody>
</table>

## Quick Check Window

<table>
<thead>
<tr>
<th>Operation</th>
<th>Key</th>
<th>Operation</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch between full screen/normal screen</td>
<td>⌘ + F11</td>
<td>Rotate left</td>
<td>⌘ + L</td>
</tr>
<tr>
<td>Switch back to normal screen</td>
<td>esc</td>
<td>Rotate right</td>
<td>⌘ + R</td>
</tr>
<tr>
<td>Switch between 50% view/fit to window</td>
<td>⌘ + F10</td>
<td>Display the first image</td>
<td>home</td>
</tr>
<tr>
<td>Add check mark1</td>
<td>⌘ + F1</td>
<td>Display the last image</td>
<td>end</td>
</tr>
<tr>
<td>Add check mark2</td>
<td>⌘ + F2</td>
<td>Display the previous image</td>
<td>⌘ + ←</td>
</tr>
<tr>
<td>Add check mark3</td>
<td>⌘ + F3</td>
<td>Display the next image</td>
<td>⌘ + →</td>
</tr>
<tr>
<td>Remove check mark</td>
<td>⌘ + F4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Edit Image Window

<table>
<thead>
<tr>
<th>Operation</th>
<th>Key</th>
<th>Operation</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences</td>
<td>+</td>
<td>Return to main window</td>
<td>+ ←</td>
</tr>
<tr>
<td>Hide Digital Photo Professional</td>
<td>+ H</td>
<td>Show/hide Tool palette</td>
<td>+ T</td>
</tr>
<tr>
<td>Hide Others</td>
<td>option + + H</td>
<td>Fit to window</td>
<td>+ 4</td>
</tr>
<tr>
<td>Quit Digital Photo Professional</td>
<td>+ Q</td>
<td>50% view</td>
<td>+ 1</td>
</tr>
<tr>
<td>Close Window</td>
<td>+ W</td>
<td>100% view</td>
<td>+ 2</td>
</tr>
<tr>
<td>Add recipe and save</td>
<td>+ S</td>
<td>200% view</td>
<td>+ 3</td>
</tr>
<tr>
<td>Add recipe and save as</td>
<td>shift + + S</td>
<td>Rotate left</td>
<td>+ L</td>
</tr>
<tr>
<td>Convert and save</td>
<td>+ D</td>
<td>Rotate right</td>
<td>+ R</td>
</tr>
<tr>
<td>Batch process</td>
<td>+ B</td>
<td>Add check mark1</td>
<td>+ F1</td>
</tr>
<tr>
<td>Page setup</td>
<td>shift + + P</td>
<td>Add check mark2</td>
<td>+ F2</td>
</tr>
<tr>
<td>Print</td>
<td>+ P</td>
<td>Add check mark3</td>
<td>+ F3</td>
</tr>
<tr>
<td>Print with Easy-PhotoPrint</td>
<td>+ E</td>
<td>Remove check mark</td>
<td>+ F4</td>
</tr>
<tr>
<td>Delete from list</td>
<td>+ delete</td>
<td>Start Trimming tool</td>
<td>option + + T</td>
</tr>
<tr>
<td>Info display</td>
<td>+ I</td>
<td>Start Stamp tool</td>
<td>option + + S</td>
</tr>
<tr>
<td>Copy recipe to clipboard</td>
<td>option + + C</td>
<td>Minimize Window</td>
<td>+ M</td>
</tr>
<tr>
<td>Paste recipe</td>
<td>option + + V</td>
<td>Cancel CMYK simulation (only functions while holding down the key)</td>
<td>space</td>
</tr>
</tbody>
</table>

### Trimming Window

<table>
<thead>
<tr>
<th>Operation</th>
<th>Key</th>
<th>Operation</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the previous image</td>
<td>+ ←</td>
<td>Switch back to normal screen</td>
<td>esc</td>
</tr>
<tr>
<td>Display the next image</td>
<td>+ →</td>
<td>Reset the trimming range</td>
<td>delete</td>
</tr>
<tr>
<td>Switch between full screen/normal screen</td>
<td>+ F11</td>
<td>Close the trimming window without saving the settings</td>
<td>+ W</td>
</tr>
</tbody>
</table>

### Copy Stamp Window

<table>
<thead>
<tr>
<th>Operation</th>
<th>Key</th>
<th>Operation</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch between full screen/normal screen</td>
<td>+ F11</td>
<td>Revert to the original condition before any corrections were performed</td>
<td>option + + Z</td>
</tr>
<tr>
<td>Switch back to normal screen</td>
<td>esc</td>
<td>Set the radius of the copy destination or correction range in 5 pixel units</td>
<td>option + + 1, option + + ↓</td>
</tr>
<tr>
<td>Display the previous image</td>
<td>+ ←</td>
<td>Set the radius of the copy destination or correction range in 1 pixel units</td>
<td>shift + + + 1, shift + + + ↓</td>
</tr>
<tr>
<td>Display the next image</td>
<td>+ →</td>
<td>Select copy source* (only functions when in 100% view)</td>
<td>option + click</td>
</tr>
<tr>
<td>Copy the content of the corrections</td>
<td>+ C</td>
<td>Change the display position after copy source is selected (only functions when in 100% view)</td>
<td>control + drag</td>
</tr>
<tr>
<td>Paste the content of the corrections copied (only functions when an image with the same number of pixels for length and width is selected)</td>
<td>+ V</td>
<td>Set the pen type to brush*</td>
<td>1</td>
</tr>
<tr>
<td>Redo the previous correction</td>
<td>+ Y</td>
<td>Set the pen type to pencil*</td>
<td>2</td>
</tr>
<tr>
<td>Redo all the corrections</td>
<td>option + + Y</td>
<td>Change the display position briefly</td>
<td>space + drag</td>
</tr>
<tr>
<td>Undo the previous action</td>
<td>+ Z</td>
<td>–</td>
<td>–</td>
</tr>
</tbody>
</table>

* Only functions when using copy stamp functions (p.1-12).